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C2000 Piccolo LaunchPad (3)

tatwe programowanie do pamieci Flash

Zestaw ewaluacyjny C2000 Piccolo LaunchPad (LANUCHXL-28027) jest dostarczany

z wpisanym do pamieci Flash uktadu procesorowego programem przykiadowego pro-
jektu Example_F2802xLaunchPadDemo. Przykiad ten pozwala na tatwe zapoznanie sie
ze sposobem organizowania projektu do pracy z pamieci Flash. Inne projekty przykta-
dowe pakietu programowego controlSUITE dla uktadéw procesorowych serii

Piccolo F2802x maja réwniez tak samo zdefiniowane konfiguracje budowania

pozwalajace na prace z pamieci Flash.

W artykule jest opisane ¢wiczenie praktyczne
z zastosowaniem biblioteki driverlib pakietu progra-
mowego controlSUITE oraz §rodowiska Code Compo-
ser Studio v5 i zestawu ewaluacyjnego C2000 Piccolo
LaunchPad. Zastosowano przykladowy projekt Exam-
ple_F2802xLaunchPadDemo i opisano jego dziala-
nie. Cwiczenie jest zorganizowane tak, ze dzialania
sa wykonywane w kolejnych punktach i krokach
uzupelnionych o szczeg6towe opisy.

Instalowanie i uzytkowanie srodowiska CCSv5.3.0
[1] oraz pakietu programowego controlSUITEv3.1.2
[2] zostalo opisane w artykule [10]. Opis pakietu
programowego controlSUITEv3.1.2 oraz zastosowa-
nie biblioteki driverlib pakietu controlSUITE zostalo
opisane w artykule [11]. Doktadny opis zestawu ewa-
luacyjnego C2000 Piccolo LaunchPad zostal zamiesz-
czony w artykule [9]. Dokladny opis ukltadéw proce-
sorowych serii Piccolo F2802x zostal zamieszczony
w ksigzce [12]. Ich dane techniczne i parametry elek-
tryczne sg zamieszczone w dokumentach [3, 4, 5]. Bu-
dowa pamieci Flash, procedura inicjalizacji pamigci
i rejestry konfiguracyjne jest oméwiona w ksigzkach
[12, 13].

Konfiguracja sprzetowa

i programowa

Do wykonania ¢wiczenia potrzebny jest komputer z zain-
stalowanym oprogramowaniem:

* Srodowisko Code Composer Studio v5.3.0 firmy Te-
xas Instruments [1, 11, 13]. Umozliwia tworzenie
w $rodowisku CCSv5 programéw przeznaczonych
dla procesoréw serii Piccolo TMS320F2802x.

e Pakiet programowy controlSUITE v3.1.2 firmy Texas
Instruments [2, 6, 7, 11, 13]. Zawiera oprogramowa-
nie ,firmware”, biblioteki, opisy zestawéw sprzeto-
wych oraz projekty przyktadowe dla wszystkich serii
procesoréw rodziny C2000.

Platforma sprzetowa wymaga tylko jednego elementu:

e Zestaw ewaluacyjny C2000 Piccolo LaunchPad firmy
Texas Instruments z uktadem procesorowym Picco-
lo TMS320F28027 firmy Texas Instruments (zawiera
kabel USB-A USB-mini) [8, 9]

W folderze C:\home_dir komputera zostanie utworzo-
ny nowy folder workEx3. Wymagane sg prawa dostepu
(zapisu i modyfikacji) dla tej Sciezki dyskowej. Mozliwe
jest umieszczenie foldera home_dir na innym wolumenie
dyskowym z prawami dostepu.

Dodatkowe informacje:
ftp://ep.com.pl, user: 75282, pass: 852sjb64
Dotychczas w EP na temat zestawu ewaluacyjnego C2000
Piccolo LaunchPad:
« ,Zestaw ewaluacyjny C2000 Piccolo LaunchPad”,
EP 01/2013
« ,,C2000 Piccolo LanuchPad (1) - Pierwszy program
w Srodowisku programowym CCS v5”, EP 02/2013
« ,C2000 Piccolo LanuchPad (2) - tatwe programowanie
z pakietem controlSUITE”, EP 03/2013

Podiaczenie i skonfigurowanie
zestawu C2000 Piccolo LaunchPad
Po zainstalowaniu $rodowiska CCSv5 [1, 10] mozna
pierwszy raz dolaczyc¢ zestaw ewaluacyjny C2000 Picco-
lo LaunchPad [8, 9] kablem USB do wolnego portu USB
komputera. System Windows automatycznie rozpoznaje
uklad. Zostang zainstalowane sterowniki systemu Win-
dows dla emulatora XDS100v2 [13]. Nalezy poczeka¢ az
system potwierdzi, ze sprzet jest gotowy do pracy.

Do poprawnej pracy programu przyktadowego wy-
magana jest podstawowa (standardowa) konfiguracja
przelacznikéw plytki drukowanej zestawu [9]:

» Zwory JP1, JP2 i JP3 konfigurowania zasilania uktadu
procesorowego Piccolo F28027. Zatozone zwory JP1
(,3V3”), JP2 (,5V”) 1 JP3 (,GND”). Oznacza to zasila-
nie uktadu procesorowego Piccolo F28027 z gniazd-
ka USB.

Przelacznik S1 konfigurowania trybu bootowania
uktadu procesorowego Piccolo F28027. Przetacznik
S1 (,Boot”) skonfigurowany nastepujgco: S1.1 - do

géry (ON), S1.2 - do géry, S1.3 - do gory. W praktyce
oznacza to bootowanie ukladu procesorowego Picco-
lo F28027 z pamieci Flash.

Przelacznik S4 konfigurowania dolaczenie portu
UART ukladu procesorowego Piccolo F28027do
uktadu emulatora XDS100v2, Przetacznik S4 (,Se-
rial”) skonfigurowany w pozycji do géry (ON). Ozna-
cza to dotgczenie portu UART ukladu procesorowego

Piccolo F28027 do ukladu emulatora, a tym samym

do wirtualnego portu COM na komputerze PC.

Program przykltadowy Example F2802xLaunchPad-
Demo automatycznie zaczyna pracowaé po dolgczeniu
zestawu do portu USB [9] (patrz ramka).

Uruchomienie srodowiska CCSv5
1. W oknie Workspace wpisz $ciezke i nazwe folderu
roboczego. Powinna by¢ ona krétka i musi by¢ zlo-
kalizowana w miejscu, dla ktérego sg uprawnienia

ELEKTRONIKA PRAKTYCZNA 4/2013

83

2013-04-01 23:18:04



Rysunek 1

¥ Clean

=

Clean will discard 31 bl problomes and bult states. The next tme a buld
ocewrs the projects will be rebulk from scratch.

Clean & profects
&l projec!

[#] Start & buid immediataly
(©Buid the entre wiorkspacel
() Buid anly the selected prajects

TE/deve lopment_kiEs/C2000_Lassehbad/ C1801x_exnmples/ CINLasnchbadbens, . ./ . . /£1005_cosmon/ cml/F28017, crt®

st Psund: FLASND, on page O

> FLASHA | FRasm | Fiassp. PaGE = O

. Opis btedu wykrytego w pliku konfiguracji pamieci

dostepu (zapisu). Dla indywidualnej pracy propo-

nowana jest $ciezka <C:/home_dir>. Dla tego ¢wi-

czenia proponowana jest nazwa folderu workEx3.

Mozna umiescic folder home_dir na innym wolume-

nie dyskowym z prawami dostepu.

Po kliknieciu na przycisk OK okna Workspace Laun-
cher otwierane jest okno startowe $rodowiska CCSv5
(i tadowane sa poszczegblne elementy srodowiska).
Mozna to obserwowac na pasku postepu. Moze to trwaé
dosy¢ diugo i nalezy koniecznie poczekaé¢ na zakoncze-
nie inicjalizacji sSrodowiska przed rozpoczeciem dalszej
pracy.

Zastosowanie projektu Example_
F2802xLaunchPadDemo
2.Dla pracy z przyktadami dla zestawu ewaluacyj-

nego C2000 Piccolo LaunchPad rozwin w oknie
TI Resource Explorer druga pozycje controlSUITE.
Nastepnie nalezy rozwina¢ drzewo controlSU-
ITE - development kits = C2000_LaunchPad -
f2802x_examples. Potem trzeba klikng¢ na nazwe
wybranego projektu Example_F2802xLaunch-
PadDemo. W prawym oknie zostanie wy§wietlona
instrukcja jak krok po kroku zbudowacé i urucho-
mi¢ projekt.

Krok1: Importowanie projektu
Example_F2802xLaunchPadDemo do
CcCs

BIx Krok1 umozliwia zaim-
portowanie wybranego
projektu do CCSv5.
3. W oknie TI Re-
source Explorer kliknij

() Clean projects selected balow

na odno$nik kroku 1.
Po poprawnym wy-

T | =

konaniu importowania

Clean

Rysunek 2.

% Erasing Flash Sectors

Okno ustawien polecenia drzewo projektu poja-
wia sie w oknie Project

Explorer i zielony zna-

y Erasing Flash Sectors.

Eramng Sackar I Teuas Insbnmants (0SL.. LIS Emulskor|C 28 Cannok be canceled)

czek v jest pokazywany
na prawo od linii nazwy
kroku.

L Projekt  Example_
[enngizend] oot ][22 | | pog0o3T qunchPadDemo

Rysunek 3. Okno informacyjne kaso- zostal  zaimportowany
wania pamieci Flash z kopiowaniem pliku

Example_2802xLaunch-
PadDemo.c do foldera roboczego projektu.

Krok2: Budowanie projektu
Example_F2802xLaunchPadDemo
Krok2 umozliwia wykonanie budowania wybranego pro-
jektu.
4. W oknie TI Resource Explorer kliknij na odnosnik
kroku 2.
W oknie Console pokazywane sg biezace informacje
o postepie budowania. W oknie Problems pokazywane
sg opisy bledéw, ostrzezen i informacji. Po poprawnym
wykonaniu budowania pokazywany jest w oknie TI Reso-
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urce Explorer zielony znaczek v' na prawo od linii nazwy
kroku.
5. W oknie Project Explorer rozwin drzewo projektu

i kliknij na jego nazwe. Zostal zbudowany projekt
w konfiguracji budowania o nazwie Flash.
Budowanie projektu Example F2802xLaunchPadDe-

mo zostalo zakonczone (prawie) poprawnie. Zostal utwo-

rzony wynikowy plik binarny Example F2802xLaunch-

PadDemo.out.

Bledy zgtaszane przez kompilator
podczas pierwszego budowania
projektu.

Po zakonczaniu pierwszego budowania projektu Exam-
ple_F2802xLaunchPadDemo zglaszane sa jednak cztery
ostrzezenia . Sg one pokazane w oknie Problems. Jesli
okno jest puste, to nalezy klikna¢ lewym klawiszem na
linie nazwy projektu w oknie Project Explorer. Linia zo-
stanie pogrubiona, co oznacza wybor projektu. Doktadny
opis pierwszego btedu z listy w oknie Problems jest poka-
zany w oknie Console (rysunek 1).

Przyczyna bledu jest wstawienie kropki zamiast
przecinka na koncu listy blokéw pamieci Flash w pliku
konfiguracji pamieci F28027.cmd (patrz ramka).

Plik znajduje sig poza folderem roboczym projektu
w standardowej $ciezce C:\TI\controlSUITE\development
kits\C2000_LaunchPad\f2802x_common\cmd.

6. Otworz plik F28027.cmd z menu File > Open File.

7. W linii 117 pliku zamien kropke na przecinek. Zapisz
zmiany do pliku. Kliknij na przycisk Save.

8. Ponownie wykonaj budowanie projektu. Kliknij na
przycisk Build na pasku narzedzi perspektywy CCS
Edit. Nie uzywaj przycisku Debug.

9. Zobacz rezultat budowania w oknie Console. Typowo
jest tam pokazana informacja: gmake: Nothing to be
done for “all’. Poniewaz zmiana dotyczyta zawarto$ci
pliku zewnetrznego to projekt nie ma o tym informa-
cji. Préba wyboru innych opcji z menu Project daje
ten sam rezultat. Jest jednak inny sposéb.

10.Wybierz z menu Project polecenie Clean (rysunek 2).
Kliknij OK.

Wykonanie polecenia Clean spowoduje usuniecie
wszystkich plikéw posrednich z poprzedniego budowa-
nia projektu i wykonanie nowego budowania od poczat-
ku. Tym razem pozostaly tylko trzy nieistotne (obecnie)
ostrzezenia.

Krok3: Definiowanie konfiguracji
sprzetowego systemu docelowego
Krok3 umozliwia zdefiniowanie konfiguracji sprzetowe;j
systemu docelowego dla projektu. Pole Connection poka-
zuje typ ,none”.
11. W oknie Project Explorer kliknij na odno$nik kroku 3.
W oknie dialogowym Debugger Configuration rozwin
liste i wybierz pozycje Texas Instruments XDS100v2
USB Emulator. Kliknij OK. Pole Connection pokazuje
teraz typ Texas Instruments XDS100v2 USB Emulator.
Zielony znaczek v jest pokazywany na prawo od linii
nazwy kroku. Utworzony plik konfiguracji sprzetowej
TMS320F28027.ccxml jest teraz pokazany w galezi
targetConfigs drzewa projektu w oknie Project Explorer.
Jest on ustawiony jako Active/Default (aktywny i domysl-

ny).
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B Loading Program: C:\home_dirwork_Ex3\Example_F...

i Laading Program: C:ihome_driwork. . Example_FZE02xLaunchPad_demo.out

[ANNNRRNNNENRRARRN NN |
(et 12 0 of 8952 at 023160 Texas Instruments XDS100v2 USE Emidabor {28

by ri in background

Run in Background Cancel Dstails >

Rysunek 4. Okno informacyjne programowania
pamieci Flash

Programowanie pamieci Flash
Programowanie pamieci Flash jest
w dwdch krokach, W pierwszym kroku pamiec¢ Flash jest

wykonywane

kasowana (rysunek 3).

W drugim kroku wpisywany jest do niej kod progra-
mu z pliku *.out (rysunek 4).

UWAGA! Zatrzymanie programowania na kroku
kasowania powoduje trwale zablokowanie dostepu do
ukladu procesorowego!

Krok4: Uruchamianie sesji
debugowej dla projektu Example_
F2802xLaunchPadDemo

Krok4 umozliwia uruchomienie sesji debugowe;j dla pro-
jektu. Dotychczas praca srodowiska CCSv5 nie wymagata
fizycznej obecnosci sprzetu docelowego. Wykonanie kro-
ku 4 wymaga wczes$niejszego dolaczenia zestawu ewalu-
acyjnego C2000 Piccolo LaunchPad do komputera z za-
instalowanym $rodowiskiem CCSv5 oraz wcze$niejszego
utworzenia sprzetowej konfiguracji docelowe;j.

12. W oknie TI Resource Explorer kliknij na odnosnik

kroku 4.

Klikniecie na odnoénik kroku 4 powoduje automa-
tyczne rozpoczecie sesji debuggowej — podobnie jak po
przycisnieciu przycisku Debug.

Wykonanie w perspektywie CCS Edit polecenia De-
bug powoduje wykonanie budowania inkrementacyjnego
aktywnego projektu, uruchomienie debuggera, automa-
tyczne dolaczenie debuggera (connection) do docelowe-
go ukladu procesorowego oraz zaladowanie/zaprogra-
mowanie kodu wynikowego (programu) do pamieci we-
wnetrznej RAM/Flash ukladu procesorowego. Otwierana
jest rowniez perspektywa CCS Debug.

Postep dziatania srodowiska CCSv5 mozna obserwo-
wac na pasku stanu w prawym dolnym rogu okna. Moze
to trwac dosy¢ dlugo i nalezy koniecznie poczeka¢ przed
rozpoczeciem dalszej pracy na zakonczenie tadowania
kodu i pokazania sie okna perspektywy CCS Debug.

Zatadowany programu jest uruchamiany i jego wy-
konywanie jest zatrzymywane na pierwszej instrukcji
funkcji main().
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Rysunek 6. Informacja o btedzie spowodowanym
brakiem wolnych putapek sprzetowych uktadu pro-
cesorowego z rdzeniemC28x

) Consoke | T Programiescry Load Optians &1
Program/Memory Load Options (TMSIZ0C2804) (7
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GEL Files FrogramiMemary Load Optiors
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s=ssion, [F yois ok Bl bo pevsist your changes for subsequent debisg
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Rysunek 7. Ustawienia projektu wymagajace uzycia
putapek sprzetowych uktadu procesorowego z rdze-
niem C28x

Debugowanie programu wpisanego

do pamieci Flash

13. Otworz okno Disassembly z menu View = Disassembly.

14. Ustaw pulapke w linii 289 z kodem myCpu = CPU_
init (); Dwukliknij na linig po lewej stronie od nume-

ru linii kodu (rysunek 5).

15. Kliknij trzykrotnie na przycisk pracy krokowej Step
Over na pasku narzedziowym okna Debug. Zobacz
informacje w oknie Console (rysunek 6).

Wszystkie procesory rodziny TMS320C2000 zawie-
rajg dwa uktady (unit) analizy AU1 i AU2. Uklad analizy
AU1 zlicza zdarzenia lub monitoruje szyny adresowe.
Uklad analizy AU2 monitoruje szyny adresowe i szy-
ny danych. Mozna skonfigurowaé¢ te dwa uklady jako
pulapki sprzetowe lub punkty podgladu (watchpoint).
Dodatkowo, ukltad AU1 moze by¢ skonfigurowany jako
40-bitowy licznik wydajnosci (benchmark). Zawartosé
licznika jest zwigkszana o jeden dla kazdego cyklu zega-
rowego CPU. Doktadny opis zagadnienia jest zamieszczo-
ny w ksigzce [12].

Ustawienie pulapki w linii kodu zrédiowego C w pli-
ku Example 2802xLaunchPadDemo.c spowodowato auto-
matyczne zastosowanie pulapki sprzetowej, poniewaz kod
jest umieszczony w pamieci Flash. Wskazuje na to ikonka
w oknie edycyjnym, z podlozonym pod kolo krzyzykiem.

Krokowe wykonanie kodu wymaga zastosowania pu-
fapki sprzetowej. Jedna zostata wykorzystana przez ak-
tywna pulapke w linii kodu. Préba krokowego wykonania
kodu przy aktywnej pulapce spowodowala zgloszenie
btedu w oknie Console. Zgtaszany przez CCS biad jest
spowodowany wykorzystaniem obu dostepnych putapek
sprzetowych. W jaki spséb zostala uzyta druga pulapka
sprzetowa?

16. Wybierz z menu pozycje Tools->Debugger

|;°”‘:“’;_ el L D . =E=S Options->Program/Memory Load Options (ry-
733 bl % e m""—"'" sunek 7).
i Lo Wybrana opcja obstugi CIO powoduje wy-

korzystanie pulapki sprzetowej (dla programu
z kodem w pamieci Flash).

17. Odznacz opcje Enable CIO function use.
Kliknij przycisk Remember My Settings. Zmia-

brekgeen!
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Rysunek 5. Projekt z ustawiong putapka

o cum focpa weting o brskpem)

P — |
rou

[ ——

- ny ustawien dla tego projektu zostang zapa-
| mietane.
| 18. Kliknij trzy razy na przycisk pracy kroko-

thamm

wej Step Over. Tym razem praca krokowa juz
dziata.
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[Can't find a souree file
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View Disassembly... |

| [Locate Fileu,|

dev/device_support/f250
surce loskup path to incl

sion/12802x_common/source/gpio.c’
its location.

Rysunek 8. Informacja o btednych sciezkach dostepu
do kodu zrédtowego biblioteki driverlib.

19. Zdejmij pulapke w linii 289. Kliknij dwukrotnie na
linie po lewej stronie od numeru linii kodu.

20. Kliknij na przycisk pracy krokowej Step Into na pa-
sku narzedziowym okna Debug.

Wyswietlany jest komunikat pokazany na rysunku 8.
Problem jest spowodowany wygenerowaniem bibliote-
ki driverlib w lokalizacji innej niz standardowa $ciezka
pakietu controlSUITE. Mozna doraznie zaradzi¢ proble-
mom dostgpu. Lepszym rozwigzaniem moze by¢ ponow-
ne zbudowanie biblioteki z poprawnymi $ciezkami, ale
wkracza to troche poza zakres tego artykutu.

21. Kliknij na przycisk Locate File. Wskaz $ciezke C:\TI\
controlSUITE\development_kits\C2000_LaunchPad\
f2802x_common\source.

Dotaczanie pliku do projektu
Skorzystanie z podgladu stanu pél bitowych rejestrow
sterowania modutu ADC wymaga dolaczenia do projektu
pliku definicyjnego struktur modelu bezposredniego do-
stepu do rejestr6w. Dla modutu ADC udostepniana jest
struktura rejestrow sterowania AdcRegs i struktura reje-
stréw wyniku AdcResult.

22. Sprawdz rozmiar pliku wynikowego Example_
F2802xLaunchPad_demo.out dostepnego w $ciezce
C:\home_dir\work Ex3\Example F2802xLaunchPad-
DemolFlash

23. Przelqcz sie do perspektywy CCS Edit.

24. Sprawdz w pliku Example F2802xLaunchPad_demo.
map (ta sama Sciezka) wykorzystanie pamieci w sek-
torach A i C pamieci Flash. W oknie Project Explorer
rozwin gataz Flash i dwukliknij na nazwe pliku. Jest to
bardzo pozyteczny plik zawierajacy doktadne informa-
cje o rozmieszczeniu sekcji wynikowych kodu i zmien-
nych w pamieci ukladu procesorowego. Zamknij pod-
glad pliku.

25. W oknie Project Explorer kliknij prawym klawiszem my-
szy na linig¢ nazwy projektu Example F2802xLaunch-
PadDemo. Z podrecznego menu wybierz Add Files oraz
sciezke  C:\Tl\controlSUITE\development kits|C2000
LaunchPad\f2802x_headers\source.

26. Zaznacz plik F2802x_GlobalVariableDefs.c i kliknij na
Otworz. W oknie File Operation zaznacz opcje Link to
files. Kliknij OK. Plik zostanie dolgczony (nie dodany)
do projektu.

27. Wykonaj samo budowanie projektu (bez ponownego
startowanie sesji debugowej). Kliknij na przycisk Build.
Nie uzywaj przycisku Debug. Na pytanie czy zatadowac
plik wynikowy kodu przycisnij przycisk Yes. Poczekaj
na zakonczenie programowania kodu do pamieci Flash.

28. Ponownie sprawdz rozmiar pliku wynikowego Exam-
ple_F2802xLaunchPad_demo.out.

29. Ponownie sprawdz w pliku Example_F2802xLaunch-
Pad_demo.map wykorzystanie pamieci w sektorach
A i C pamieci Flash.

Rozmiar kodu wynikowego po dotaczeniu pliku

F2802x_GlobalVariableDefs.c nie zwigkszyl sie.
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FLASHC 003£2000 00002000 0000120c
FLASHA 003£6000 00001£80 00001£80

Wykorzystanie pamigci w sektorach A i C przez sek-
cje kodu jest takie samo przed i po dofgczeniu pliku.

Za to rozmiar pliku wynikowego Example
F2802xLaunchPad_demo.out zwiekszyl sig ze 196KB do
241KkB. Jest to spowodowane wieksza liczba danych de-
bugowych wstawionych do tego pliku.

Wglad w projekt Example_

F2802xLaunchPadDemo

30. Przefacz sie do perspektywy CCS Debug.

31. Zapoznaj si¢ z komentarzem na poczatku pliku
Example_2802xLaunchPadDemo.c.

Krotki opis projektu przykladowego oraz zalozenia

i wymagania sprzetowe sg zamieszczone na poczatku

gtownego pliku kazdego projektu przykltadowego z pa-

kietu programowego controlSUITE.

32. Dodaj zmienne referenceTemp i currentTemp oraz
struktury AdcRegs i AdcResult do okna Expressions.
Dwukliknij w oknie edytora na nazwe zmiennej (za-
znacz). Kliknij prawym klawiszem myszy na zazna-
czong zmienng. Z podrgcznego menu wybierz Add
Watch Expression i kliknij OK.

Konfigurowanie do pracy z pamiecia

Flash

W projekcie  Example F2802xLaunchPadDemo  sg

dotaczone dwa pliki definicyjne pamieci. Jeden to plik

DSP2802x_Headers_nonBIOS.cmd. W perspektywie CCS

Edit jest on widoczny w drzewie projektu w oknie Project

Explorer. W pliku sg zdefiniowane struktury (rejestrow)

modutéw peryferyjnych uktadu procesorowego oraz mo-

dutu PIE. Jest on stosowany dla projektéw bez uzycia sys-
temu czasu rzeczywistego (SYS/BIOS).

Podstawowe zdefiniowanie uzytych w projekcie ob-
szar6w pamieci ukladu procesorowego jest zamieszczo-
ne w drugim pliku. Lecz jego umiejscowienie w projekcie
nie jest takie proste. Drugi plik F28027.cmd jest wskaza-
ny w opcjach wywolania linkera.

33. W oknie Project Explorer w perspektywie CCS Edit klik-
nij prawym klawiszem myszy na lini¢ nazwy projektu
i z podrecznego menu wybierz pozycje Properties.

34. W oknie Properties for Example F2802xLaunchPad-
Demo rozwin gataz Build->C200 Linker->File Search
Path (rysunek 9). Pozwoli to na sprawdzenie usta-
wien linkera.

W polu opcji linkera “-1” jest wskazanie na plik
${INSTALLROOT LAUNCHXL F28027_V100}/f2802x_
common/cmd/F28027.cmd”. Podana jest Sciezka dostgpu
do pliku zdefiniowana posrednio poprzez symbol $ciezki
instalacji pakietu firmware dla zestawu ewaluacyjnego
C2000 Piccolo LaunchPad. Jest to $ciezka inna niz dla
standardowego pakietu firmware. W pakiecie progra-
mowym controlSUITEvV3.1.2 zostal dla zestawu ewalu-

"% Propertie: for Example F2802 sunchPadDema —— — |zl
e fiar bt File Search Path ol S
Resource
General - ’
4 Build Configuration: |Fiash | Active | 5 | Mensge Goniigantionss|
2000 Compiler
o CEO00 Linker
Basic Optians
R Inchude by e or command Fle input Sk, 1) 41 ) &
Achvanced Opbors | T E R N T R e T T =
vt 2800 _mallib” 1
- Tammath k"

| TekTeg

Rysunek 9. Dotaczenie drugiego pliku konfiguracyj-
nego pamieci do projektu
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acyjnego zastosowany skopiowany standardowy pakietu

firmware F2802x w wersji V100 (starej).

35. W oknie Properties for Example F2802xLaunchPad-
Demo kliknij na galaz Build oraz otworz zaktadke
Variables. Zdefiniowane sg tam symbole $ciezek (ry-
sunek 10).

To nie sg jedyne predefiniowane symbole w projekcie.
36. Rozwin gataz Build->C2000 Compiler->Advanced

Options->Predefined Symbols. Sa tam zdefiniowane

inne wazne symbole np. Flash” oraz ,, DEBUG”.

Nastepne wazne symbole sg zdefiniowane w pliku
konfiguracji pamieci.

37. W perspektywie CCS Edit zobacz zawarto$¢ pliku
F28027.cmd (patrz ramka).

Na poczatku pliku F28027.cmd zdefiniowane sg do-
stepne obszary pamieci z przypisaniem do przestrzeni
adresowej programu — Page0 lub przestrzeni adresowej
danych - Page1.

Nastgpnie w pliku F28027.cmd wykonywane jest
przypisanie sekcji do zdefiniowanych na poczatku ob-
szar6w pamieci. Kazda sekcja inicjalizowana musi by¢
przypisana do pamieci nieulotnej Flash. Sekcja kodu
o nazwie .text jest przypisana do pamieci Flash w sek-
torach A, CiD.

Sekcja ramfuncs jest zdefiniowana w specjalny spo-
s6b. Dla niej okreslony jest adres tadowania (LOAD) do
pamieci Flash (adres FLASHA). Pod tym adresem bedzie
zaprogramowana zawarto$¢ sekcji w trakcie fadowania
kodu. Zdefiniowany jest réwniez adres wykonania (RUN)
w pamieci RAM (adres PRAMLO). Jest to adres, pod ktéry
zostanie przepisana zawartos¢ sekcji z pamieci Flash do
pamieci RAM. Przepisywanie jest wykonywane w progra-
mie uzytkownika. Nastepnie z sekcjg ramfuncs zwigzane
sg zmienne (symbole) jezyka C z dostepem na poziomie
asemblerowym. Dlatego ich nazwy sg na poczatku uzu-
petnione znakiem podkreslenia. Dokladne omoéwienie
zagadnienia jest zamieszczone w ksigzce [13].

W pliku Example F2802xLaunchPad_demo.map jest
pokazane rozmieszczenie sekcji w pamieci po wykona-
niu budowania projektu.

g | 6 Bt | 30 S | 0 Yoretes | BB Bt | 5 Lk e | = Do
s
a0 Carvpdn o Tr =
- CINB Lkt INSTALUROOT_ LAGPCHIL 130007 V100 Diciory _3{0PUCAL PROICT ROOTL-
eI

B b OFIGIMAL PROCT_S00T Domctory  Cices

F owsdasl s [

R)-lsun_ek_10. Zdefiniowane symboli $ciezek dla projektu

Przepisywanie kodu programu

z pamieci Flash do pamieci RAM
Inicjalizacja ustawien rejestréw konfiguracyjnych pamie-
ci Flash uktadu procesorowego serii Piccolo F2802x musi
by¢ wykonywana przez kod umieszczony w pamigci RAM.

Kod przeznaczony do wykonywania z pamigci RAM
jest przypisywany przez linker do sekcji ramfuncs z uzy-
ciem dyrektywy #pragma CODE SECTION. W pliku
flash.c (Sciezka f2802x_common/source/) zastosowana
jest linia przypisania
#pragma CODE SECTION (FLASH setup,
“ramfuncs”) ;

W pliku flash.c wszystkie funkcje obstugi rejestréw
konfiguracyjnych pamieci Flash sg przypisane do sekcji
ramfuncs. Do tej sekcji jest réwniez przypisany kod z pli-
ku F2802x_asmfuncs.asm projektu przyktadowego.

Dla sekcji ramfuncs linker definiuje trzy symbole:

e RamfuncsLoadStart — adres tadowania (LOAD) do
pamieci Flash (adres FLASHA). Pod tym adresem
bedzie zawarto$¢ sekcji zaprogramowana w trakcie
fadowania kodu.

* RamfuncsRunStart — adres wykonania (RUN) w pa-
mieci RAM (adres PRAMLO). Jest to adres, pod ktéry
zostanie przepisana zawarto$¢ sekcji z pamieci Flash
do pamieci RAM.

* RamfuncsLoadSize — rozmiar obszaru do przepisania.
Linker ustawia warto$¢ tych symboli na podstawie

pliku konfiguracji pamieci F28027.cmd. Symbole te sg
udostepniane jako zmienne w pliku F2802x_GlobalVaria-
bleDefs.c dotaczonym do biblioteki driverlib.

extern Uintl6é RamfuncsLoadStart;

extern Uintl6é RamfuncsLoadSize;

extern Uintlé RamfuncsRunStart;

Dziatanie programu przyktadowego Example_F2802xLaunchPadDemo

Zestaw ewaluacyjny C2000 Piccolo LaunchPad (LANUCHXL-28027) jest dostarczany z wpisanym do pamieci Flash ukfadu
procesorowego programem przykfadowym Example F2802xLaunchPadDemo.

Program automatycznie zaczyna pracowac po dotgczeniu zestawu do portu USB. Swieca kolejno cztery diody LED wskazujac
na prawo — na przycisk S3. Po przycisnieciu (i przytrzymaniu) na przycisk S3 (prawy) program przechodzi do pomiaru we-
wnetrznej temperatury ukfadu procesorowego.

Dodatkowo program przyktadowy wysyta informacje poprzez port szeregowy uktadu procesorowego typu UART. Aby je
wykorzystac nalezy najpierw zidentyfikowaé numer wirtualnego portu COM. W tym celu nalezy klikna¢ prawym klawiszem
myszy na Mdj komputer (np. w menu Start). Wybra¢ Wiasciwosci a nastepnie Sprzet oraz Menedzer urzadzen. Na liscie Porty
(COM i LPT) nalezy znalez¢ port o nazwie USB Serial Port (COMX), gdzie X jest numerem.

Program przyktadowy byt uruchamiany z obstuga komunikacji na PC poprzez program PuTTY (do pobrania darmowo ze stro-
ny http://www.putty.org/). Proby zastosowania innych programéw komunikacyjnych nie daty dobrych rezultatéw. Poprawna
praca wymaga ustawienia parametréw komunikacji 115200 8N1. Po uruchomieniu programu PuTTY wybierz typ potaczenia
Serial a nastepnie wpisz poprawny numer portu COM oraz szybkos¢ transmisji i kliknij Open.

Na razie w oknie programu PuTTY jest pusto. Nalezy teraz przycisng¢ przycisk reset RST (S2, lewy). Zostanie wyswietlona
spora plansza.

Zgodnie z wyswietlanym napisem przycisnij przycisk S3 (prawy). Po nacisnieciu przycisku mierzona jest aktualna tempera-
tura wewnetrzna uktadu procesorowego i zapisywana jako temperatura odniesienia Tref (w stopniach Celsjusza). Program
przechodzi do trybu cyklicznego pomiaru temperatury biezacej Tcur. Program pokazuje réznice temperatury biezacej i odnie-
sienia: Tcur-Tref. Swiecaca lewa dioda LED (D2), o wadze w zapisie binarnym 1000b réwnej wartoci dziesietnej 8, oznacza
zgodnos¢ temperatury biezacej z temp. odniesienia (Tref+0°C). Dodatnia réznica temperatur zwieksza wyswietlang binarnie
wartos¢ a ujemna roznica jg zmniejsza. Czyli pokazywany zakres jest niesymetryczny od Tref-7 (0000b) do Tref+8 (1111b).
W prawym dolnym rogu planszy wyswietlanej na PC przez program PuTTY jest pokazywany rezultat aktualnego pomiaru.
Oprocz aktualnej réznicy pokazywana jest tam tez aktualna temperatura w stopniach Celsjusza.

Ponowne przycisniecie przycisku S3 powoduje ustawienie temperatury odniesienia na warto$¢ temperatury biezacej.
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Zawarto$¢ pamieci Flash od ad- 40.
resu poczatkowego wskazywanego
przez RamfuncsLoadStart jest prze-
pisywana do pamieci RAM, rozpo- 41.
czynajac od adresu wskazywanego
przez RamfuncsRunStart. Uzywana
jest funkcja memcpy z biblioteki cza-
su wykonania rts2800_ml.lib.
38. w pliku Example
F2802xLaunchPadDemo.c kliknij 42.
(zaznacz) na linig 316 z kodem

Rysunek 11 Ustawienia
parametrow wypetniania
obszaru pamieci RAM

memcpy (&RamfuncsRunStart,
&RamfuncsLoadStart,
(size t)&RamfuncsLoadSize) ; 43.
39. Kliknij prawym klawiszem (poza tekstem kodu) i wy-
bierz pozycje Run to Line. Program zostanie urucho-
miony i zatrzymany na zaznaczonej linii kodu

Plik definicji pamieci F28027.cmd

Dodaj zmienne RamfuncsRunStart, RamfuncsLo-
adStart oraz struktury RamfuncsLoadSize do okna
Expressions.

Otworz okno Memory Browser z menu View = Memory
Browser. Wybierz przestrzen adresowa Program, wpisz
adres 0x8000 (RamfuncsRunStart ) i kliknij Enter. Za-
warto$¢ pamieci nie jest przypadkowa, poniewaz kod
zostal juz przepisany przez program uruchomiony po
wlgczeniu zasilania zestawu uruchomieniowego.
Kliknij prawym klawiszem myszy w oknie Memory
Browser i wybierz Fill Memory. Wpisz adres startowy
0x8000, przestrzen adresowa Program, diugo$¢ 0x20
oraz warto$¢ wstawiang zero (rysunek 11).

Na pasku narzedziowym okna Memory Browser klik-
nij na przycisk Open New View. Przeciagnij nowe
okno pamieci tak, aby byto ulozone ponizej poprzed-
niego (rysunek 12).

RAM/FLASH/OTP) blocks can be moved to PAGEl for data allocation */
on-chip RAM block LO */

0x000400 /* on-chip OTP */

0x002000 /* on-chip FLASH */

0x001F80 /* on-chip FLASH */

MEMORY

{

PAGE 0: /* Program Memory */

/* Memory (

PRAMLO : origin = 0x008000, length = 0x000800 /*

OTP : origin = 0x3D7800, length =

FLASHD : origin = 0x3F0000, length =

FLASHC origin = 0x3F2000, length = 0x002000 /* on-chip FLASH */
FLASHA origin = 0x3F6000, length =

CSM_RSVD origin = 0x3F7F80, length =

/* all 0x0000 when CSM is in use. */

0x000076 /* Part of FLASHA. Program with */

BEGIN : origin = O0x3F7FF6, length = 0x000002 /* Part of FLASHA. Used for “boot */

/* to Flash” bootloader mode. */
CSM PWL PO
/* locations in FLASHA

IQTABLES origin = 0x3FE000, length =
IQTABLES2 origin = 0x3FEB50, length =
IQTABLES3 origin = 0Ox3FEBDC, length =
ROM : origin = 0x3FF27C, length =
RESET : origin = 0x3FFFCO, length =
VECTORS origin = Ox3FFFC2, length =
PAGE 1 /* Data Memory */
/* Memory (RAM/FLASH/OTP) blocks can be moved to
/* Registers remain on PAGEL
BOOT RSVD
/* this for stack */
RAMMO : origin = 0x000050, length = 0x0003B0 /* on-
RAMM1 : origin = 0x000400, length = 0x000400 /* on-
DRAMLO origin = 0x008800, length = 0x000800 /* on-
FLASHB origin = 0x3F4000, length = 0x002000 /* on-

}

/* Allocate sections to memory blocks.
Note:

codestart user defined section in DSP28_CodeStartBranch.

used to redirect code execution when booting to flash
ramfuncs user defined section to store functions that
will be copied from Flash into RAM

*/
SECTIONS

/* Allocate program areas: */

.cinit : > FLASHA | FLASHC | FLASHD, PAGE = 0
.pinit : > FLASHA | FLASHC | FLASHD, PAGE = 0
.text : >> FLASHA | FLASHC | FLASHD, PAGE =
Codestart > BEGIN PAGE = 0

ramfuncs : LOAD = FLASHA,

RUN = PRAMLO,

LOAD START (_RamfuncsLoadStart),
LOAD_SIZE (_RamfuncsLoadSize),
RUN_START (_RamfuncsRunStart),

PAGE = 0
csmpasswds > CSM_PWL_PO PAGE = 0
csm_rsvd > CSM_RSVD PAGE = 0

/* Allocate uninitalized data sections: */

.stack : > RAMMO PAGE =

.ebss : > DRAMLO PAGE = 1

.esysmem > DRAMLO PAGE = 1

. sysmem > DRAMLO PAGE = 1

.cio : >> RAMMO | RAMM1 | DRAMLO PAGE = 1

/* Initalized sections go in Flash */

origin = Ox3F7FF8, length = 0x000008 /* Part of FLASHA. CSM password */
*/

0x000B50 /* IQ Math Tables in Boot ROM */
0x00008C /* IQ Math Tables in Boot ROM */
0x0000AA /* IQ Math Tables in Boot ROM */

0x000D44 /* Boot ROM */
0x000002 /* part of boot ROM */
0x00003E /* part of boot ROM */

PAGEO for program allocation */
x/

origin = 0x000000, length = 0x000050 /* Part of MO, BOOT rom will use*/

chip RAM block MO */
chip RAM block M1 */
chip RAM block LO */
chip FLASH */

asm

/* For SDFlash to program these, they must be allocated to page 0 */

.econst
.switch

}
Spory kawatek pliku to zakomentowane definicje potrzebne
Zostaty one pominiete.

> FLASHA PAGE = 0
> FLASHA PAGE = 0
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44. W nowym oknie wybierz przestrzen adresowg Pro- drzewa pakietu firmware. Z tego pliku s R :vf %
% gram, wpisz adres 0x3F70C2 (RamfuncsLoadStart) inkludowane sg nastepne dwa pliki: e s e [“']‘* 4
t i kliknij Enter. e F2802x Device.h — umieszczo- ~ ® # enfucsirstan wod* ososxo
= - # * RamfuncsioadStart  voud * CwFPOCE
= 45. Kliknij na przycisk pracy krokowej Step Over na pa- ny w tym samym miejscu. Zde- s e i
sku narzedziowym okna Debug. Zauwaz zgodno$¢ finiowane s3 w nim symbole o
§ zawartosci obu obszar6w adresowych pamieci. opisujace uzywany uklad sca- = vessentiy | O temorytrovee 2 S0
o lony. Domyslnie definiowane — "J = = él‘
= Inicjalizowanie ustawien pamieci sa symbole w tym: P e ——r
= Flash #define TARGET 1 B
i Dostep do r6znych obszaréw pamieci wewnetrznej uktadu #define DSP28 28027PT TAR- el i
3 procesorowego wymaga réznej liczby cykli op6znienia. Dla GET E*EEEE:
pamieci RAM opdznienia majg stalg wartos¢, a dla pamieci e F2802x Examples.h (Sciezka / CAoRt
Flash i OTP op6znienia sg programowane przez uzytkownika f2802x_common/include/) b g :
w rejestrach konfiguracyjnych. Przed rozpoczeciem konfigu- Zdefiniowane jest w nim makro DE- et ®
rowania pamieci Flash wszystkie dostepy do pamieci Flash LAY US wyskalowane w mikrose- B reoeom= ‘; Bl P _ 2
lub OTP musza by¢ zakoriczone. Dotyczy to instrukcji znaj- kundach oraz symbole z warto§ciami g v [mame B (o] [
Progeanls3T0e2 <Mamiey Aehderia 2 |

dujacych sie w potoku CPU, odczytéw danych, oraz operacji domys$lnymi ustawien dla F28027

b 16 88 - T1 Sl Hee %0

OxIF70CZ  FamfuncalosdScart A
BB =ooc zeam o1F7 740

0x3FF0CT 8017 7640 2042 FEOT 7700

0x3F70CC  FF69 0DDS 7622 1AC4 OO0

Ox3FTOD1  T61A FFG9 0006 7622 DEEC

OxIF70D6  761A FF6S 0006 7622 S6E4 &

pobierania kodu z wyprzedzeniem. Budowa pamieci Flash,
procedura inicjalizacji pamieci i rejestry konfiguracyjne jest
doktadnie oméwiona w ksigzkach [12, 13].

Inicjalizowanie ustawienn pamieci Flash jest wyko-

Piccolo w tym:

CPU RATE 16.667L // for

a 60MHz CPU clock speed

(SYSCLKOUT)

#define CPU_FRQ 60MHZ 1 //

60 Mhz CPU Freq (10 MHz dla przepisywania kodu

input clock) z pamieci Flash do RAM
Inne symbole definicji zegara to CPU_FRQ 50MHZ

oraz CPU_FRQ_40MHZ.

Rysunek 12. Zmienne ste-

nywane w funkcji FLASH_setup(myFlash) z biblioteki rujace i obszary adresowe

driverlib.

46. W pliku Example F2802xLaunchPadDemo.c kliknij
(zaznacz) na linie 348 kodu FLASH setup(myFlash);
Zaznacz ta linie, kliknij prawym klawiszem (poza
tekstem kodu) i wybierz pozycje Run to Line.

47. Kliknij na przycisk pracy krokowej Step Into na pa-
sku narzedziowym okna Debug.

Uruchamianie projektu Example_
F2802xLaunchPadDemo

48. Dodaj zmienng strukturalng FlashRegs do okna 50. Kliknij na przycisk Resume na pasku narzedziowym
Expressions. Wpisz jej nazwe w pole Add new expres-

sion. Rozwin drzewo struktury FlashRegs oraz struk-

okna Debug. Opis dziatania programu i jego obstu-
gi jest zamieszczony w ramce ,Dziafanie programu

+
tury bitowe rejestru FBANKWAIT (rysunek 13). przyktadowe- T.. - -
b~ Varishles |G Expressions (3, B Regiters SE| F X R MG
Pole bitowe RANDWAIT okresla czas oczekiwania go Example Earaion Tepe Voon Address
dla swobodnego dostgpu do pamieci Flash. Pole bitowe F2802xLaunch- e b NG
4 . . . 4 [ bit struct FRANKWAIT BITS () 0000 AB6 G Dat:
PAGEWAIT okresla czas oczekiwania dla stronicowanego PadDemo”. o3 RANCWAIT  funcigned et 2 1 Py
. . P . . i dl (unsgned intSd) o D000 ABS DD
dostepu do pamieci Flash. Dokladne oméwienie zagad- Zaprezento- e e &gt
e rveid {unsigned intdd) ] D000 A5 B Diata

nienia jest zamieszczone w ksigzce [12]. wane w artykule
postepowanie po-

zwala na poznanie

Rysunek 13. Ustawienia zdefiniowania

49. Stosujac przycisk Step Over przejdZz w pracy kroko- opbznienia dostepu do pamiei Flash

wej do konca kodu funkcji FLASH setup (linia 336
kodu). Zobacz jak zmienita sie wartos¢ liczby cykli
opo6znienia dostepu do pamieci Flash.

programowania pamieci Flash uktadéw procesorowych
Piccolo F2802x w S$rodowisku programowym CCSv5.

Okazuje sig, ze nadal op6Znienie jest ustawione na do- Uruchamianie przykladowego projektu z pakietu progra-

mys$lng (maksymalna) liczbe 15 cykli zegara systemowego.

Brak zmiany jest spowodowany blednym brakiem
aktywnego kodu w funkcji FLASH_setup biblioteki dri-
verlib dla symbolu definicji zegara CPU_FRQ 60MHZ,
ustawionego w tym projekcie.

mowego controlSUITEv3 umozliwia poznanie sposob6w
pracy programu z pamieci Flash uktad6w procesorowych
Piccolo F2802x.

Henryk A. Kowalski
kowalski@ii.pw.edu.pl

Typowo w kazdym projekcie wlaczony jest plik naglow-
kowy DSP28x_Project.h znajdujacy sie na gléwnym poziomie
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